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Introducing VPN Tracker 365 
Welcome to VPN Tracker, the leading VPN client on Mac. Whether you are new to VPN or a seasoned VPN guru, this manual will help you get 
started with VPN Tracker. 

New to VPN Tracker? 

● Install VPN Tracker and start your free demo in → Getting Started 

System Administrators and IT Departments 

● Connect to your existing VPN or set up a VPN  from scratch in 
 → Getting Connected 

● Set up VPN Tracker for others in → Exporting Connections 

Where to go for help 

● Questions about a specific device or protocol? Refer to our Compatibility Guides for device- or protocol-specific setup instructions 
● Questions about VPN Tracker 365 plans or functionality? Refer to our extensive list of FAQs 
● Problems with setup or in need of advice? Get in touch with our Support Team 
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VPN Tracker 365 Plans 
We offer four different VPN Tracker 365 plan tiers to fit your requirements:  

 

Check out our Buyer’s Guide for a full overview of what each plan offers. 

 
Tip: Regardless of the plan you have purchased, you can always download and use the same copy of the VPN Tracker application. Your license will automatically unlock all the 
features included in your plan. 
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Installing VPN Tracker 365 

You can always download the latest version of VPN Tracker 365 from the VPN Tracker 365 website. Once downloaded, move VPN Tracker 365 to your Applications folder.  
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When you first launch VPN Tracker 365 on your Mac, you will be prompted to install 
the VPN Engine and authorize the System Extensions that lets VPN Tracker’s VPN 
Engine access network packets and do its thing. 

This step needs to be done on your Mac with VPN Tracker in your Applications folder 
and can’t be carried out remotely (i.e. via Remote Desktop.) 

 

 

 

 

 

In the next step, you’ll be prompted to open System Preferences → Security & 
Privacy.  Here you need to “Allow” VPN Tracker 365’s System Extension. 

 

 

Finally, you will also need to allow VPN Tracker 365 to add VPN configurations.  
Note for Admins: For Enterprise rollouts via MDM, you can also pre-approve the 
VPN Tracker Kernel Extension using a special profile. Our Team IDs are CPXNXN488S 
and MJMRT6WJ8S. 

http://vpntracker.com/download


 

Your VPN Tracker 365 account 
Accessing your VPN Tracker 365 account is quick and easy. You can start using your plan in a few seconds over any internet connection.  

How many plans do I need? 

VPN Tracker 365  is licensed per-user, so each user that wants to use VPN Tracker needs their own plan.  

Testing VPN Tracker 

If you want to make sure VPN Tracker 365 works with your connection and meets your expectations before purchasing, you can test the demo version for free. This will give you 
access to all VPN Tracker Pro features (except exporting connections). All you need to do to get started is create a free account: 

 

Tip: If you set up your VPN connection during your free demo period, VPN Tracker 365 will keep all your settings and details once you purchase a license. 

To purchase a license: Visit vpntracker.com/buy   
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Getting Connected 

VPN Crash Course 
Is this your first time working with a VPN? Read this chapter to get you up to speed. 

VP...What? 

VPN Tracker allows your Mac to securely connect to another network over the Internet. Even if your office is located in San Francisco and you're on a business trip in New York, 
you can work with your applications and files, as if you were in your office.  

 

How does it work? 

As the name implies, VPN Tracker uses VPN (Virtual Private Network) technology to create a connection between your Mac and your remote network. And unlike normal Internet 
connections, a VPN Tracker connection is encrypted. Think of a VPN as a highly-secure tunnel through the Internet, your very own "secure line" to your office. 

In order to use a VPN, you'll need your Mac running VPN Tracker on your end of the connection. On the other end of the connection (the remote side), you need a VPN gateway 
that accepts your incoming VPN connection. 

Once you have set up your connection in VPN Tracker and on the device at your remote location, you are ready to connect and start working remotely using your normal tools 
and applications. 
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What do I need? 

To create a VPN connection from your Mac, you need three things: 

● VPN Tracker 365 
● An Internet connection 
● A VPN gateway 

If you’re reading this, you probably already have VPN Tracker and an Internet connection for your Mac. So what about a VPN gateway? 

VPN Gateway 

A VPN gateway is a hardware device (or in some cases specialized software running on a regular computer) that accepts incoming VPN connections, creating a secure tunnel 
between its local network and your Mac. In most cases, a VPN firewall or a router with built-in VPN capabilities will act as the VPN gateway. 

If there are existing VPN users in your organization you probably already have a properly configured VPN gateway. If not, don’t worry – check out this blog post for some tips on 
what to look for when buying a VPN gateway. 

What kind of VPN connections does VPN Tracker support? 

VPN Tracker 365 supports all industry standard VPN protocols: 

● IPSec 
● OpenVPN 
● L2TP 
● PPTP 
● SonicWALL SSL 

Our configuration guides can help you get started with setting up a connection for your chosen VPN protocol.   
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The Big Picture 

Add a New Connection 

● Click the button in the lower left hand corner of the VPN Tracker 365 window and select “New Company Connection...” 

 
 
  
 
 

You will see a list of device profiles. We have device profiles for all the VPN gateways that VPN Tracker has been tested with: 

  

● Select your VPN gateway from the list. If your VPN gateway is not listed, click the button “Use custom device profile”. 
● Click “Create” to add the new connection   
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Basic Settings 

Let’s take a closer look at the essential settings that VPN Tracker 365 needs to connect to your VPN gateway. Depending on your device, some settings may not be shown. 
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Advanced Settings 

You likely won‘t have to modify any settings on the Advanced tab, unless: 

● your device uses different settings than the factory defaults and/or the settings proposed in the configuration guide, or 
● there is no device profile for your device in VPN Tracker 

In both cases, the goal is to have VPN Tracker’s settings for Phase 1 and Phase 2 match exactly what is set up on your VPN gateway.  

 
Completing Setup 
When you‘re done configuring your VPN, click the „Done“ button on the upper right corner to leave edit mode. 

Tip: It is not necessary to leave edit mode to save the connection or to connect to the VPN. If you make changes while the VPN is connected, reconnect the VPN to apply them. 

Now that you have a basic idea how to set up a connection in VPN Tracker 365, you’re ready to apply it to your specific situation. 
 

Did you receive a VPN Tracker connection from your administrator? 
● The next chapter shows you how to use the connection in VPN Tracker.   

 

11 



 

Importing Connections 
Find out how to import a connection that you have been given by your IT department or VPN administrator. 

Import Your Connection(s) 

● Locate the connection in Finder and double-click it. Or open VPN Tracker and choose “File > Import > VPN Tracker Connection…” from the menu: 
 

 
 

● You will be asked for the import password. If you don’t know the  import password, please ask the person who gave you the connection. 

Replacing Existing Connections 

If you already have the connection you’re about to import, you’ll be asked whether to replace your existing connection, or if you would prefer to add this connection as a copy: 

Replacing a connection 

If your new connection replaces your existing connection, click “Replace”. Your existing connection will be overwritten.  

Adding a copy 

If you would prefer to keep your existing connection and import the new copy, click “Add Copy”.  You’ll find the imported connection further down in your connection list. It will 
have the word “copy” appended to its name, e.g. “Office copy”. 

Replacing existing VPN Shortcuts 

Connection files can also include VPN Shortcuts. If the included VPN Shortcuts already exists, you will once again be asked whether you would prefer to replace your existing 
VPN Shortcut or add a new VPN Shortcut as a copy.   
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Connecting to Your New VPN 
When you’re done setting up your VPN, you’re ready to connect. To test your VPN, go to a location outside of the network that you want to 
connect to. 

Connecting 
Click the on/off slider to connect the VPN: 

  

If you are using VPN Tracker 365 for the first time with your current Internet connection,  Connection Checker will test your connection. Wait for the test to complete. 

If prompted, enter your pre-shared key and Extended Authentication (XAUTH) username and password. 

 

Connected?  

Connecting may take a couple of seconds. If the On/Off button turns blue that’s great – you’re connected!   

Continue with the next chapters to find out how to use VPN Tracker 365 and your VPN connection effectively. 

Problems? 

If there is a problem connecting, VPN Tracker will give you helpful advice and troubleshooting tips. To learn more about troubleshooting VPN connections, visit the chapter → 
Troubleshooting 
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VPN Shortcuts: Your VPN Cockpit 
Shortcuts give you one-click access to the files, documents and applications you need to do your work over your VPN connections.  

Setting up Shortcuts 
This video tutorial shows you how to quickly set up VPN Shortcuts in VPN Tracker 365 and save them in your Connection Safe. 
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Connecting to a File Server 

This video shows you how to easily access file servers over VPN using Shortcuts: 
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Managing your Connections 
Locking Connections 

You can lock a connection to prevent it from being modified (VPN > Lock Connection…). During this step, you will be asked to enter an unlock password which will need to be 
entered should you or another user need to make changes in the future: 

 

To prevent others from modifying connections you export for them, enable locking in the export settings. 
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Organizing Connections in Groups 
 

If you have a lot of connections, it will be useful to divide your connections up into groups, e.g. by client, by branch office, by geographical location etc.  

To add a new group, click the ‘+’ icon in the lower left hand corner of the window and select ‘New Group’: 

 

You can drag & drop connections and VPN Shortcuts Collections between groups to rearrange them: 
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To rename, delete or control a group of connections, use the gear menu on the right side of the group. 

Tip: An exported connection knows the group it belongs to, and will recreate it as needed.  

Searching Connections 

 

If you are a consultant or admin looking for a specific connection, use the search box at the top of the sidebar to find it: 
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VPN Connection Stats 
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When connected to your VPN, you can see statistics for your connection in the 
sidebar.  

The traffic graph lets you know how much data is currently being sent and received 
over your VPN connection, as well as the total amounts of data transferred, and the 
maximum throughput seen in the last measurement period.  

It also lists the algorithms that are in use and the current network settings. 

 

 

 

Menu Bar Item 
 
You can also control VPN Tracker 365 directly from your menu bar, allowing  you full 
control over your VPN connection, without having to leave the application you’re 
working in: 

 

 



 

App Notifications 
VPN Tracker 365 shows push notifications whenever something interesting happens to your VPN: 

  

You may customize these notifications in “VPN Tracker 365” > “Preferences” > “Notifications”: 
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Connection Actions 
You can configure your VPN connection to carry out certain actions on launch. To get started, go to a connection, click “Configure” and go to “Actions”: 

 
 
Connect this VPN when VPN Tracker is opened 

Enable this option to automatically connect to this VPN whenever VPN Tracker is opened. 

Locations 

If you use multiple network locations on your Mac (System Preferences > Network), VPN Tracker can automatically connect or disconnect your VPN connection, depending on 
the current network location. 

● Switch the slider to “On” to automatically connect in this location 
● Switch the slider to “Off” to automatically disconnect in this location 

Wi-Fi Networks 

With this action, VPN Tracker 365 will automatically connect to your VPN whenever your Mac connects to the wireless networks you have specified.   
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Actions After Connecting 

VPN Tracker 365 can take care of any tasks that need to be performed after the VPN connects.  

For example, if you always need to connect to a file server, enter it here to make sure it’s available any time you connect the VPN. Or, if you want to open your company’s 
intranet website whenever you connect, enter it here. 

Tip: Actions can help you to be even more productive with VPN Shortcuts. For example, if you have certain applications in your VPN Shortcuts Collection that require a file 
server to be connected, add that file server here to ensure that it’s always available to your VPN Shortcuts items. 

 

Actions Before Disconnecting 

If there’s anything that needs to be done before the VPN is disconnected, add it here.  VPN Tracker 365 automatically adds an action to disconnect all file servers that use the 
VPN. 

Notes 
If you would like to make a few notes – for yourself, or for others that you’re setting up this VPN for, the Notes tab is the right place: 

  

● Notes are included with exported connections 
● When exporting Accounting records, the reference number and organization can be included for use with billing systems 
● All information from the Notes tab is displayed on the Status tab   
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Connection Safe 
What is Connection Safe? VPN Tracker 365 Connection Safe keeps your VPN connections safe and backed-up. Using state-of-the-art cryptography, 
Connection Safe uses encryption to tie your connection to your personal equinux ID, so only you can access your connections. 
 
Visit our website to learn more about Connection Safe 

Saving a VPN Connection in the Connection Safe 
Once you have set up a VPN connection in VPN Tracker 365, it is best practice to back the connection up in your Connection Safe. This way, you will not have to configure the 
connection again if you get a new Mac.  
 
To save a connection, right click on the connection in the sidebar and click “Add to Connection Safe ...” 
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You can see whether or not a connection has been backed up if the Connection Safe icon appears next to it in the sidebar: 
 
 

Backing up VPN Shortcuts in the Connection Safe 
As well as VPN connections, if you have a VPN Tracker 365 Pro or VIP plan, you can also save your VPN Shortcuts to your Connection Safe. This allows you easy access to all your 
most-used VPN workflows wherever you are working and means you don’t have to configure new Shortcuts if you get a new Mac. Learn more about Shortcuts in → VPN 
Shortcuts 
 
Just as described above for saving connections, to add a Shortcuts Collection to your Connection Safe, right click on the collection and click “Add to Connection Safe ...” 

Managing your Connection Safe 
You can view the Connection Safe status of a particular connection, by opening the Connection Safe tab: 

 
 
Here you can add or remove connections to your safe and also sync your connection if you have made any changes. 
Tip: VPN Tracker 365 syncs with your Connection Safe sync every 10 minutes. 
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Connection Checker 
What is Connection Checker? Connection Checker automatically tests new network environments, figures out which VPN standards are supported 
and optimizes your connection. Connection Checker quickly connects to VPN Tracker 365 servers and determines which settings to use for successful 
VPN connections.  
 
Visit our website to learn more about Connection Checker 

Accessing the Connection Checker 
To open the Connection Checker, go to the “Tools” menu and click “Open Connection Checker”: 
 

 
 
Alternatively, you can open and collapse the Connection Checker widget by clicking on the icon in the bottom left corner of the app window: 
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Performing a Connection Check 
If you are experiencing difficulties with your internet connection or connecting to a new network for the first time (e.g. at a hotel or cafe), performing a connection check is the 
best way to diagnose any network issues and determine whether the VPN protocol you need is supported. 
 
Once you have the Connection Checker open, you will see your current network and a list of VPN protocols. Check the box next to the protocols you want to test, or check 
“Select All” if you want a general overview. Click “Start Connection Check” to test the connection and identify which of the selected VPN protocols are supported.  
 

 
 
Under each protocol, you will see how many of your saved VPN connections use this protocol. Click on a protocol for more specific detail: 

 

 
 

 

 
 
   

 

26 



 

Troubleshooting unsupported protocols 

VPN protocols which aren’t supported are indicated by a yellow warning icon: 

 
 

Tracking network locations 
The “Network Locations” tab in the Connection Checker window is a useful reference to help you keep track of all your previously tested networks and their test results. 
 

 
 

Adjusting your Connection Checker settings 
You can configure Connection Checker in the “Settings” tab. Activating options such as “Auto test when connecting in new Network Locations” make your VPN workflow much 
easier. 
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Network Scanner 
 

The Network Scanner in VPN Tracker 365 Pro lets you explore the remote network of your VPN, assist users and easily locate available hosts 
and services. 

Scanning Networks 
To scan a network, your Mac must be connected to the network via VPN.  

● Select the VPN connection in the sidebar and start the connection. 
● Go to the “Net Scanner” tab. 
● Click the “Scan” button in the bottom right corner to scan the network using a selection of the most popular network services: 

 

If you are connected to a VPN where all network traffic is sent through the VPN (Host to Everywhere), VPN Tracker 365 will ask you to specify the network that you would like to 
scan. 
Depending on the size of the network and your Internet connection, the scan may take a while to complete. You can continue working with VPN Tracker 365 while a scan is in 
progress. You’ll receive a notification when the scan is complete. 
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Customizing Network and Services 

By default, the Network Scanner scans for a selection of the most popular network services. 

● To select different services, click the settings  icon and check or uncheck the services that you would like VPN Tracker 365 to scan 
for: 

● To turn OS detection* on or off, use the checkbox at the top of the settings. 
● To check/uncheck all services, hold down the Option key while clicking a checkbox. 
● To restore the default selection of services and networks, click the “Defaults” button at the top of the settings.   

*What is OS Detection? The Network Scanner can detect the type of host (e.g. macOS, Windows, Linux, Network Equipment, Printers) from 
the services that are available on that host. 

● OS detection requires certain services to be included in the scan. If you uncheck a service that is required for OS detection, OS 
detection will be unchecked as well.  

Tip: At the bottom of the settings, you can change the network that is being scanned. Select one of the remote networks of the VPN, or enter 
a custom range or IP address. The more addresses a scan includes, the longer it will take to complete.   
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Scan Results   

Using Scan Results 

Connect to Services 

You can connect to a service right from the Network Scanner, or open the app associated with this service on your Mac. 

● Display the scan results ”By Address” or “By Service”. 
● On the right side, click the “Connect” or “Open” for the service or host that you would like to connect to: 

 

 

 

 

 

 

 

 

Add to VPN Shortcuts Collection 

● To add a service as VPN Shortcut, click the ‘...’ button for the service that you would like to add to a VPN Shortcuts Collection. 
● Choose “Add to VPN Shortcuts” and select the VPN Shortcuts Collection that you want the service to be added to: 
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Customizing Scan Results 
 
Renaming Hosts 
Renaming hosts in the Network Scanner list makes it easy to locate your most important computers and network devices. 

● Display the scan results ”By Address”. 
● Right click the host you want to rename. 
● Choose ”Rename” and enter a name: 

 

Automatic Hostname Lookup 

VPN Tracker 365 can automatically look up the hostnames for IP addresses in the Network Scanner. All you need is a Remote DNS server for your VPN that can provide host 
names for the IP addresses that are being scanned (reverse DNS lookup). Make sure the checkbox “Use for reverse lookup of IP addresses in remote networks'' (Basic > DNS) is 
checked: 

 

Setting a Custom Icon for a Host 

● Display the scan results ”By Address”. 
● Right click the host you want to change the icon for and click “Choose icon...” to set a custom icon for this host. 
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Change the OS Detection Group 

The Network Scanner automatically detects the kind of host – whether it’s macOS, Windows or Linux, or a printer or network equipment. OS detection uses the services on a 
host to determine the most likely type of host. OS detection might put a host into a different group than what it actually is. You can change the group if a host is not detected 
correctly. 

● Display the scan results ”By Address” 
● Right click the host whose group you want to change. 
● Select the new group from the “Group” menu: 

 

 

Resetting Scan Results 

● Click ”Reset Scan Results” in order to clear the results. Customized host names, icons, and groups will not be modified – if the host is encountered again in a future 
scan, the customization will be applied. 

● Hold down the Option key while clicking ”Reset Scan Results” in order to also reset all customization (names, icons, and groups). 
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Accounting 
 

If you have a VPN Tracker 365 Pro or VIP plan, you can use the Accounting feature to track the time you were connected to your VPN. It can 
assist you with billing your clients and documenting your work.   

 Customize the Display 

● To select the month for which data is being displayed, click the back/forward buttons next to the month. 
● To select the columns displayed in the Accounting table, right-click the table header and check or uncheck the columns. 

 

Add Comments 

You can add a comment for every connection to your client‘s VPN. This helps you to keep track why you used the connection on this day and also makes billing easier: 
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Exporting Accounting Data 

VPN Tracker 365 Pro not only tracks connection time for you, it also lets you export this data for Numbers or Excel, or to third-party time tracking or billing systems that can 
import CSV files: 

● Click ”Export” in the bottom right corner of the ”Accounting” tab 
● Choose ”Export for Numbers…” or ”Export for Excel…” depending on with which application you want to use the data with 

○ To export data in a customizable CSV format, choose “Custom Export…“ 

 

The export can include data for one or more connections, simply select additional connections from the “Connection” popup. 

Reference Number and Organization: To integrate VPN Tracker 365’s accounting with your own time tracking or billing system, an organization and a reference number can 
be set for each of your VPN connections in the “Notes” tab of the configuration window.   
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InfiniConnect 
 

 

VPN Tracker 365 InfiniConnect (available in Pro & VIP plans) automatically detects connection interruptions and reconnects your VPN, 
giving you peace of mind to focus on your work. This video shows you how it works: 
 

 

Visit our website to learn more about InfiniConnect. 
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Exporting Connections 
 

Whether you’re quickly exporting a VPN connection for a coworker, or rolling out VPN Tracker 365 to hundreds of users, VPN Tracker 365’s 
sophisticated export and convenient installer is there to help. 

Exporting a Connection 
Once you have set up and tested a VPN connection, you can export it for other VPN Tracker users. 

To export a connection 

● Select the connection 
● Choose “File” > “Export”: 

 

● The export window will now open. If you are exporting a connection for users of previous versions of VPN Tracker 365, be sure to select the appropriate file format 
from the “Export File Format” menu: 
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Tip: Not all features are available in previous versions of VPN Tracker. When exporting for earlier versions of VPN Tracker, we recommend testing the exported connection in the 
respective version before rolling it out to end users. 

● We recommend you make your export more secure by setting an encryption password for the file. Users of this connection will be required to enter the password once 
when importing the connection, so be sure to keep a record of the password you choose. 

 

  
Tip: To export multiple connections in a single file, select the connections you would like to export (hold down the ⌘ key to select more than one), and choose File > Export…. 
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Exporting a VPN Shortcuts Collection 

You can also export VPN Shortcuts Collections for your users, along with their connections. Simply select the Shortcuts Collection in the sidebar -  along with any VPN 
connections you wish to export - when exporting (hold down the ⌘ key to select more than one item in the sidebar): 

 

Tip: In the Export Settings, you can choose to automatically export a Shortcuts collection alongside a VPN connection. This helps end users gain access to their most important 
VPN services faster. 
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Export Settings Explained 

VPN Tracker 365 provides admins with a large amount of configuration options for when you choose to export a VPN connection for team members to work with. Access these settings by 
heading to the “Configure” tab of your connection and clicking “Export Settings” at the bottom of the window: 
 

 

 

Pre-Shared Key 

 

Include pre-shared key from keychain 

If you have saved the pre-shared key in your keychain, VPN Tracker 365 can include this pre-shared key with the exported connection.  

Permit pre-shared keys to be stored in and loaded from the keychain 

Checking this option will (a) move an included pre-shared key into the user’s keychain when importing the connection, and (b) permit users to store their pre-shared key in the 
keychain if none is included with the exported connection.   
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Extended Authentication (XAUTH) 

 

Include XAUTH login and password 

If you are using Extended Authentication (XAUTH), you can also include a user’s XAUTH credentials (username and password) in the exported connection.  Select whether you 
would like to include the username and password stored in your keychain, or be asked for an XAUTH username and password when exporting the connection. 

Permit XAUTH credentials to be stored in and loaded from the keychain  

Checking this option will (a) move included XAUTH credentials into the user’s keychain when importing the connection, and (b) permit users to store their XAUTH password in 
the keychain if none is included with the exported connection. 

Connection Safe 

 

Here you can choose from the options to determine whether or not you want the VPN connection to be stored in the user’s Connection Safe.   
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Security 

 

Remote Connection Wipe (Recommended) 

This setting gives you the ability to remotely wipe the VPN connection from a user’s account (including the Connection Safe) - i.e. if they leave the company or lose their Mac. 

Don’t allow settings to be changed 

This setting prevents users from making accidental or undesirable changes to their VPN connections. The connection is “locked”. Users will be able to see the connection 
settings, but will not be able to modify them. 

Hide settings and detailed logs 

Hides the Basic and Advanced tabs, as well as the more detailed log levels. Only basic logging and troubleshooting information is displayed. Technical Support Reports cannot 
be created unless an unlock password is set. 

Temporarily permit editing with unlock password (Recommended) 

With an unlock password, the connection can be unlocked temporarily, for example if an administrator needs to make changes at a user’s computer. 

Tip: If you don’t set an unlock password, there will be no way to ever make any changes to the exported connection or use a Technical Support Report to analyze a technical 
problem.   
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VPN Shortcuts 

  

If you have configured a VPN Shortcuts Collection, you can choose to include it with your exported connection.  

Use a VPN Shortcuts Collection to access all the services they need VPN for – network shares, internal websites, databases, and applications. 

VPN Shortcuts selected here are always included when exporting this connection. If you’d like to export additional VPN Shortcuts, simply select them together with your 
connection before exporting. 

Actions 

 

If you have configured actions to be executed when the connection is connected or disconnected, you can include them as well. Any settings you have configured in your 
connection’s “Actions” tab will be included. 

Contact info 

 

If your VPN users run into any issues, they can email you a Technical Support Report with details about their connection settings, local internet connection and VPN logs. The 
email address you enter as your contact info will be set as the default recipient of the report. 
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Other Day-to-Day Considerations 

Unlock Password 

Experience has shown that when exporting a locked connection, you‘ll want to unlock it at one point or the other – whether it‘s making a quick change at an end user‘s Mac, 
accessing an end user‘s Technical Support Report, or even importing the (locked) connection onto your own Mac and accidentally replacing the (unlocked) original.  

● If you do not set an unlock password for a locked connection, there is no way to ever change settings.  
● If you do not set an unlock password and hide the settings and logs, there‘s no way to ever access the settings. 

Certificates 
If your connection uses certificates for authentication, keep in mind that the certificates are not included with the exported connection. You’ll need to distribute the certificates 
as you would normally do. 

VPN Tracker 365 will automatically attempt to use the same certificates on the Mac where the connection is imported. If they are not available, the user will be prompted to 
select new certificates.  

Overwriting Existing Connections 

If you have made changes to a connection that you have already distributed to your users, it’s a good idea to reuse the same connection when exporting (instead of creating a 
new one).  

That way, your users will be prompted to replace their existing connection with the updated one, instead of ending up with another copy, and in the end not knowing which 
connection is the current one. 
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Troubleshooting 

Missing Settings 
If you forgot to fill in a setting, VPN Tracker 365 will point it out to you: 

 

Connection Errors 
In case of any other problem, a yellow warning triangle will show up: 

 

Click on the yellow warning triangle to be taken to the log. The log will explain exactly what the problem is. Follow the steps listed in the log to resolve the problem. 
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Tip: Press Cmd-L to open the log in a new window. That way, you can have the log side-by-side with your VPN configuration window while making changes to troubleshoot a 
problem. 

If you need additional help, you can email the log to your administrator, or send a Technical Support Report (TSR) to equinux or to your network administrator. This contains the 
settings and logs necessary for resolving technical problems. Confidential information (e.g. passwords, private keys for certificates) is not included in the TSR. 

Tip: You can use the dropdown menu at the bottom of the “Log” window to change the level of the log depending on how complex the issue is:  
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No Access to the Remote Network 

If your VPN appears to be connected, but you cannot access resources (servers, email, etc.) in the remote network, check the following points to resolve the problem. 

Connect to an IP address (instead of a host name) 

If you are using a host name (e.g. fileserver.example.com) to connect to the resource, please try using its IP address instead. 

If the connection works when using the IP address, but not when using a host name, please make sure that your Mac’s DNS server is able to resolve this host name to an IP 
address, or set up a suitable remote DNS server in VPN Tracker.  

Check that the IP address you are connecting to is part of the VPN’s remote network 

Check that the IP address you are connecting to is part of the remote network(s) of the VPN. Also double-check the network mask that you have configured for the remote 
network(s) in VPN Tracker 365. If you're using SonicWALL Simple Client Provisioning or Cisco EasyVPN, the remote network(s) are assigned by your VPN gateway. You can see 
these on the Status tab. 

Make sure the host you are trying to reach knows where to send replies 

Start with checking if your local address is part of the remote network: 

● Connect the VPN 
● Go to the Status tab 
● Compare the IP address listed under “This Mac” (local address) and the networks listed under “Remote Network”. Is the local address part of the remote network(s)?  

 

In this example, the local address 192.168.213.189 is part of the remote network 192.168.213.0/24   
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If the local address is part of the remote network(s): 

There are exactly three setups where the local IP address may be part of the remote network(s). If your setup is not one of these, you must choose a local address that is not 
part of the remote network(s). 

1. When connecting to a SonicWALL using SonicWALL Simple Client Provisioning or DHCP over VPN. 
2. When connecting to a Cisco VPN gateway using Cisco EasyVPN. 
3. When connecting to a VPN gateway that can act as an ARP proxy for IP addresses assigned through Mode Config, and/or for fixed local addresses. 

That third one is a bit tricky to figure out. If you find a reference to ARP Proxy (or Proxy ARP) in the device’s documentation, or if the manual specifically instructs to choose the 
local address or the Mode Config address pool to be part of the remote network, then it’s ok for the IP address to be part of the remote network. 

In all other cases you must choose an IP address as the local address (or a Mode Config address pool) that is not part of the remote network(s). If you are using Mode 
Config, you need to change the Mode Config address pool on the VPN gateway. Otherwise, simply change the local address in VPN Tracker (Basic > Local Address).  

If the local IP is not part of the remote network(s): 

Check if your VPN gateway is the default gateway (router) of its network.  

If your VPN gateway is not the default gateway of the remote network, you will have to ensure that responses to all IP addresses used by VPN clients are routed to the VPN 
gateway. You can do so either by adding a general route on the network’s actual default gateway, or by adding individual routes on each host that VPN clients need to 
communicate with. 
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Troubleshooting Remote DNS 

If you can access resources on the remote network using their IP addresses, but not their host names, you will need a suitable remote DNS setup. 
 

Prerequisites for remote DNS: 

● A DNS server that is able to resolve those IP addresses exists. 
● The DNS server can be reached through the VPN. 

To illustrate the steps for debugging remote DNS issues, here’s an example setup using remote DNS: 

● We have a VPN connection to the remote network 192.168.42.0/24. 
● In this network, there’s a file server fileserver.example.com. 
● We can reach this file server using its IP address 192.168.42.10. 
● We’d like to reach this file server using its host name fileserver.example.com.  
● This host name cannot be looked up using public DNS servers, but there is an internal DNS server with IP address 192.168.42.2 that is able to resolve hosts in the 

example.com domain, including fileserver.example.com. 

 

For remote DNS settings to take effect, the VPN needs to be reconnected. We should now be able to connect to fileserver.example.com using its host name. 
 

Tip: If you set a remote DNS server for “All Domains” instead of specific “Search Domains”, make sure it is a working DNS server that can resolve hosts on the Internet. 
Otherwise, your Mac will seem to be cut off from the Internet when the VPN is connected. 
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Steps to Troubleshoot 

If connecting using the host name does not work, the first step is to use the DNS Lookup Tool to verify that the host name can be looked up. 

● Connect the VPN, Go to “Tools” > “DNS Lookup” in the menu bar on top of the screen 
● Enter the host name (here: fileserver.example.com) and click “Lookup” 

 

If the DNS Lookup Tool displays the expected result, remote DNS is configured correctly. In that case, the problem is with the actual connectivity, not DNS. If DNS lookup fails, 
then the problem is with remote DNS.  
 
The next step is to figure out if the problem is with the remote DNS server itself, or with the remote DNS setup. 

● Open a Terminal window (Applications > Utilities > Terminal) 
● Enter: dig <host name> @<remote DNS server> and press return. In our example: dig fileserver.example.com @192.168.42.2 

If you see an “Answer Section” with the correct IP address, then both the connectivity to the DNS server, and the DNS server’s response are ok. In that case, the problem lies with 
the remote DNS setup. Double-check the configuration in VPN Tracker 365. 

 

If you don’t see an “Answer Section” with the correct IP address, then the remote DNS server is not configured to resolve fileserver.example.com. If you get a timeout error, then 
the remote DNS server is not reachable over the VPN or it is not a properly configured DNS server.    
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Managing VPN Tracker 365 Plans 
The VPN Tracker 365 service allows you to easily view and update information regarding your VPN Tracker 365 plan online. It also has all the 
necessary tools in place for network admins to successfully set up and manage multiple plans for a team of VPN users. 

my.vpntracker.com 
All VPN Tracker 365 plans can be managed via my.vpntracker.com. Here you can view your current VPN Tracker 365 plan, access your Connection Safe, and also create a team 
and assign plans to users.  

To get started, log in to the secure online portal using your equinux ID and password 

Managing your personal account 
After logging in to my.vpntracker, the first thing you will see is the VPN Tracker 365 plans that are currently assigned to you:  
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Under the “My VPN Tracker” menu on the left, you can view all information 
associated with your personal VPN Tracker 365 account. Here you can also:  

● View the validity period of your VPN Tracker 365 plan and manage your 
renewal preferences on plans you have purchased 

● Keep track of your active devices and remove any devices which are no 
longer in use 

● Manage your payment methods 
● Access and download your past invoices 
● Make changes to your account (i.e. update your equinux ID)  

To manage your VPN Tracker 365 team(s), go to the “Team Management” tab. 

https://my.vpntracker.com/


 

Team Management 
To set up a new  team or manage an existing team, go to the Team Management tab:  

 

Creating a VPN Tracker 365 Team 

Creating a VPN Tracker 365 Team is the best way for network admins to manage multiple plans and users. To get started, enter a team name and click on “Create Team”: 

 

You will now have the opportunity to start building up your team and inviting new members. 
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Inviting team members 

To add members to your team, all you need to do is enter their email address and click “Invite”: 

 

 The invited team member will then receive an automatic email invitation with a personalised link to click on and join your team. 

Tip: Each VPN Tracker 365 user needs their own equinux ID. After the user receives a team invitation from you and clicks the invite link, they can either create a new equinux ID or log in 
using their existing account.  

This video provides more information: 
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Assigning VPN Tracker 365 plans to users 

If you have purchased multiple VPN Tracker 365 plans for your team, you can assign each plan to a user so your colleagues can use VPN Tracker 365 on their Macs. You can 
purchase additional plans at any time from the Team Store. 

Available plans will show up on the left of the window: 

 

Assign a plan to a user by clicking “Assign plan” and choosing an available plan from the dropdown list. If no plans are available, you will be notified and can proceed to purchase 
more VPN Tracker 365 plans from the Team Store. 

You can keep track of which users have been assigned which plan under the “Team Members” list. In this area, admins can also manage your team members’ plans. 

 

Tip: Remember that a VPN Tracker 365 plan is assigned to a user for a specific device. Sharing of accounts and simultaneous use of multiple devices is not permitted in any way.  
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Managing plans in your team 

If you need to upgrade a user to a different plan option (e.g. from VPN Tracker 365 Standard to VPN Tracker 365 VIP), you can do this by clicking “Change plan...” The duration of 
the user’s original plan will be available for you to assign to another team member if required. Here you can also revoke a VPN Tracker 365 plan if you made a mistake, or if the 
user doesn’t need the plan any more: 

 

If a user leaves your team or does not need their VPN Tracker 365 plan any more, you can easily remove this user and revoke access to their plan. By clicking “Remove member”, 
any connections the user has which are locked to your team will be automatically wiped from their account and associated devices. 

If you suspect a security breach is possible (e.g. a team member’s MacBook has been lost or stolen), you can remotely wipe the connection from their device. Just click "Suspend 
& Wipe" next to the user in the team member list. 

Team Settings 

You can access your team’s settings in the "Settings" section, found in the left sidebar of the "Team Management" tab. 

Here you can:  

● Rename a team, 
● Export a list of team members for your records, 
● Delete your team permanently 
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Creating groups for your team 

If you have many users in your team, it helps to create groups. For example, you could set up a group for all colleagues from marketing or other departments in your company.  

Tip: When using VPN Tracker 365 VIP plans, you can also lock a connection to certain groups to use the Remote Connection Wipe functionality.  

To create a group, go to the "Team Management" tab and click "Manage" in the "Group" section. Click "Create Group…" and enter a group name:   

 

Adding users to a group 

After you have created your group, select the group by clicking its name. Click "Add members…" You will now see a list of all available team members to add to the group: 
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Using the Remote Connection Wipe function 

All VPN Tracker 365 plans allow you to use VPN connections that are connected to a certain group and can be remotely removed from all team members' computers. This helps 
you prevent unauthorized VPN access. 

Follow these three simple steps to set up Remote Connection Wipe 

1. Set up a connection and lock it to your team or a specific group 
2. Export a connection and distribute it to your team 
3. Suspend users from a team and remotely delete all locked connections 

Set up a VPN connection that is locked to a certain group 
After you have configured your VPN connection, you can enable the Remote Connection Wipe functionality for this connection.  

1. Select your connection from the left sidebar 
2. Click "Configure" and open the "Export Settings…" 
3. In the section "Security" tick the option "Remote Connection Wipe" 
4. Tick your team or the groups you want to lock the connection to: 

 

 
 

5. Click "Close" to save your changes 
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Export your locked connection and share it with your team 

Once you have enabled the Remote Wipe Connection functionality for your VPN connection, export your connection and distribute it to your team.  

To do so 

1. Choose your connection from the left sidebar in the VPN Tracker app 
2. Choose "File > Export" from the top menu bar 
3. Set an export location and enter an import password for maximum security: 

 

  
 

4. Click "Export" 

Tip: In the export window you will also see a short message that this connection is locked to your team or a group. Click "Edit…" for faster access to the security export settings. 

You can now send the exported connection to your team member. All  they have to do is to double click the file and to enter the import password (if you have one.) The 
connection is then available in VPN Tracker 365 and ready to use. 
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Suspend users and remotely delete connections 

Everything is now set up so you can suspend and remove users from a group and remotely wipe all locked connections if necessary. In order to suspend and wipe, please follow 
these steps: 

1. Log in to https://my.vpntracker.com using your equinux ID and password. 
2. Open the "Team Management" tab. 
3. Click "Suspend & Wipe…" You will see a popup confirmation window. 
4. Now, click "Suspend & Wipe Connections". The suspended user will then appear under the list “Suspended” where they can be removed or reinstated at any time: 

 

 Tip: Please note that this will wipe all connections the user has that are locked to their team, as well as any groups from their computer.  
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Managing Payments and Subscriptions 

Besides managing and assigning VPN Tracker 365 plans, you can also manage subscriptions and payments, change subscription renewal settings, or download invoices for your 
purchases via my.vpntracker. 

Open the "Account" tab and click "Payment Methods" in the left sidebar:  

 

Here you can enable or disable the auto-renewal for subscriptions and see further details like the credit card that will be used to renew your subscriptions. 

Click "Invoices" in the left sidebar to access all the invoices for your equinux ID. Even for non VPN Tracker 365 purchases: 
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Managing your Connection Safe 

my.vpntracker also lets you access and modify your Connection Safe. In the “Safe” tab, you can view all of your stored VPN connections and Shortcuts: 

 

Click the “Delete” button to permanently erase a VPN connection or VPN Shortcuts from your Connection Safe and all of your Macs. Please note, this action cannot be reversed. 
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